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Preface

Thank you for selecting the MONITOUCH V6 series.
For proper set-up, you are requested to read through this booklet to understand more
about the product.

For more information about V6 series, refer to the following manuals.

Contents Name of Manuals Ref. No.

Shows wiring for each PLC, setting of | V6 Hardware Specifications 2006NEXx
"communication parameter" etc.

The V-SFT operating procedure is Reference Manual (Operation) | 1043NEXx
described.

The functions and instructions of V7/V6 | Reference Manual (Function) 1044NEXx
series are described.

Shows exercises in V-SFT edit. V-SFT Tutorial 1022NEx

Shows how to connect and set Temperature Control Network 1033NEx
Temperature Control Network

For further details about the PLC, see the manual attached to each PLC.

Notes:

1. This booklet may not, in whole or in part, be printed or repro-
duced without the prior written consent of Hakko Electronics Co.,
Ltd.

2. Information in this booklet is subject to change without prior
notice.






Notes on safe usage of MONITOUCH

In this "Specifications for V609E", you will find various notes categorized under the following
three levels with the signal words "Danger," "Warning," and "Caution."

These signal words are to warn the user of possible misuse of the unit. To comprehend the
critical notes on the safe procedure, you must go through this manual before you install
MONITOUCH and operate it correctly.

Danger
DANGER indicates an imminently hazardous situation which, if not
avoided, will result in death or seriousinjury.

Warning
WARNING  jndicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.

Caution

caution  Indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury and could
cause property damage.




Notes on System Design

WARNING

Never use the input function of MONITOUCH such as the touch switch
for an emergency switch because it could threaten a human life or
break a part of the unit.

Please design the system of the unit in order to respond to a malfunction

of the touch switch.

CAUTION

Prevent the static electricity from being charged on the sheet metal
where MONITOUCH is mounted in order to avoid malfunction caused

by noise.

Never bundle input/output cables with high-voltage and large-current
cables such as power supply cables. Keep input/output cables at least
200mm away from power supply cables in order to avoid malfunction
caused by noise.

As for the use in the facilities related to nuclear energy or in the facilities

of official importance, please consult with our distributer about it.

Notes on Installation

CAUTION

Operate MONITOUCH under the conditions indicated by the manual.

If you don't set the conditions indicated by the manual for the unit, it

could cause fire, malfunction, physical damage or deterioration.

Maintain the following conditions in order to avoid fire or trouble.

Don't let the unit come in contact with corrosive gas, flammable

gas, solvents, grinding fluids or cutting oil.

Never let the unit be exposed to high temperature, high humidity,
and other outside weather conditions.

Don't allow the unit to be exposed to excessive dust, salt, and
metallic particles.

Don't allow the unit to be shaken or hit by other objects.




Equipment must be correctly mounted so that the main terminal will

not inadvertently be touched during an application.

Notes on Cable Connection

Turn off the power supply when you set up the system or connect the

cables, otherwise you will get an electric shock or damage the unit.
DANGER

Connect the cables correctly to the terminals of MONITOUCH in
CAUTION accordance with the specified voltage and wattage. Over-voltage, over-
wattage and the incorrect cable connection could cause the unit to be

damaged physically or functionally and also could result in fire.

Ground FG terminal which must be for the unit. The level of grounding

resistance is less than 100€2.

Prevent any conductive particles from entering into MONITOUCH.
The conductive particles could cause fire, trouble, or malfunction of

the unit.

Notes on Maintenance and Operation

Never touch the terminals while the power supply is on, otherwise

DANGER you will get an electric shock.

You must put the cover of the terminals on the unit when you turn on

the power and operate it.

The liquid crystal in the LCD panel is a hazardous substance. If the
LCD panel is damaged, never swallow the leaked liquid crystal. If the
liquid crystal spills on your skin or clothing, use soap and wash off

thoroughly.




CAUTION

Hakko Electronics Co., Ltd. is not responsible for an unauthorized

person who may fix, disassemble, or reconstruct any unit.

Avoid displaying the same patterns for hours. It may cause afterimages
due to the property of LCD display. If you use the fixed patterns for
hours, use the auto-OFF function of the backlight.
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1 Special Features

1) High-intensity EL Display
Adopts the high-intensity EL device to ensure wide angle of field of view.
Can create easy-to-view screen thanks to orange-yellow display on black background color.

2) High-resolution switch mesh
Uses 40 (W) x 20 (H) touch switches adopting the matrix resistance film.
Allows setting and arranging of switches in a variety of styles.

3) Interface with GD-80E compatibility
Hardware and software designed with replacement of GD-80E (Monitor GD8O0 series, EL display type)
taken into consideration ensure easy model change.
Inheriting the specifications such as 640 (H) x 400 (V) dot resolution, 8.9-inch screen size and panel cutout
dimensions from GD-80E, V609E is released as user friendly high-level model to ensure smooth replace-
ment of GD-80E.
For the connection to a PLC, the converter to maintain compatibility of wiring is optionally available.

4) Two built-in modular ports
As with V6 series, two built-in ports of modular jack are provided to ensure compatibility to wide range of
functions such as temperature control network and multi-link 2.

* Please note that the maximum baud rate is 57,600 bps.
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2 Notes on Usage

Environmental Limits

1. Use MONITOUCH at an ambient temperature of

0~50°C, and a relative humidity of 85 %RH.

2. Install a forced fan or an air conditioner to
maintain the ambient temperature when it is
higher than the above mentioned range.

3. Avoid places where moisture may easily con-
dense due to sudden temperature changes.

5. Never install MONITOUCH in a place where
impacts or vibrations may be transmitted.

Q)
g

6. Avoid any place in which there is the possibility
that water, corrosive gas, flammable gas,

solvents, grinding fluids or cutting oil can come in
contact with the unit. Never install the unitin a
place where dust, salt and metallic particles are
present.

Locations

1. Secure sufficient space around MONITOUCH for
ventilation.

2. Never attach MONITOUCH to the top of any
apparatus generating high levels of heat (heater,
transformer, large-capacity resistor, etc.).
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. Never install MONITOUCH in the same compart- 5. In a dry environment, MONITOUCH may generate

ment as high-voltage equipment. The unit should a large amount of static electricity.

be at least 200 mm away from high-voltage lines Therefore, before touching the unit, touch a

or power cables. grounded metallic section to discharge the static
electricity.

6. Securely fasten and lock every connector for each
cable. Double-check this before turning the power

/ on.

Usage

. An emergency stop circuit must be composed of
an external relay circuit with a start signal for
MONITOUCH built in. Do not create switches on 7~ Application of thinner may discolor MONITOUCH.
MONITOUCH to be used in case of emergency. Use alcohol or benzine available commercially for

cleaning.
/ lwnch to be used
. |s:-\ in emergency

Emef§gncy
Sto ‘

. In case of using a waterproof sheet (GD-WP80E), 8. Never remove any printed circuit board from
mount it in the unit by using 6 pieces of mounting MONITOUCH. (This will harm the unit.)
screws (normally 4 pieces of them).

. MONITOUCH has a glass screen. Never drop or
subject the unit to strong impacts.

9. Never operate the display by using a tool with a
sharp point like a screwdriver.
Touch the display by fingers.

. Tighten mounting screws with the following

torques.
atool with a
sharp point
Position of Screw Screw Size Torque (N - m) like a screwdriver
Mounting Screw M3 0.3-0.5 (3-5kgf - cm)

Note :Never fasten these screws too tightly,

otherwise the cover of MONITOUCH may be

deformed. 1. Use all the display area evenly and avoid using
fixed patterns which may cause afterimages so that
the life span of the display can be expanded.
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3 System Composition

System Composition/Model Indication/Peripheral Equipment

System Composition
The following illustration shows possible system configurations using V609E.

During operation
(Link communication)

RS-232C/RS-422

screen data

During operation Link Unit
(Universal serial

Panel Editor
for V series Transferring

Creating screens

Personal Computer (PC)

Transferring /\ A /\ communication)
screen data RS-232C/RS-422 ~
Transferring or \
screen data Memory manager —
V6-CP /Data logging ———
CREC-CP Universal-purpose
computer

Cable

Card Recorder
CREC Printer Cable V6-BCD

V6-PT

Barcode Reader

Cable
V6-TMP

Printer

Temperature Controller

Model Indication

V609E30M[ |

L Blank : 100-240VAC type
D : 24VDC type (Comply with CE/UL/cUL)

Matrix type (Touch switch)
3 : SRAM + Built-in clock function

High-intensity EL (Display Device)
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Peripheral Equipment

The following options are available for using V609E more effectively.

V-SFT (Panel Editor for Windows98/NT4.0/Me/2000/XP)

Application software for editing display data for V series.

V6-CP (Data Transfer Cable) 3m

Connects V6 to a personal computer, or a personal computer to CREC.

V6-PT (Printer Cable) 2.5m

Connects V6 to a printer.
* When using CBM292/293 printer, our printer cable “V6-PTCBM” is available.

CREC (Card Recorder)

Reads display data created by personal computer, or works as an external

memory storage system for the memory manager and data logging func-
tions.

REC-MCARD (Memory Card)

Complies with JEIDA Ver.4.0

Used as a recording medium for display data back-up and for the memory
manager or data logging function.

SRAM 256K, 512K, 1M, 2M, 4Mbyte

FLASH ROM 256K, 512K, 1M

M-CARD SFT (Memory Card Editor)

Application software for editing data stored in a memory card.
(For Windows98/NT 4.0/Me/2000/XP)

V-1/O (Serial Extension I/O)

Used as an external I/O unit for PLC. It has 16 inputs and 16 outputs.
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1 System Composition

TC485 (Terminal Converter)

Used for connection between a V6 and a PLC at the RS-422/485 terminal
block.

V-MDD (ACPU/QnACPU/FXCPU Dual Port Interface)

Add-on connector with two ports, specifically designed for the connector on
the MITSUBISHI's ACPU/QnNACPU/FXCPU programmer. This can improve
operability of the ACPU/QnACPU/FXCPU programmer that is directly
connected.

TC609 (Terminal converter for V609E)

The communication board that allows the use of existing communication
cable used with GD-80E.

V6-BCD (Cable for Barcode Reader) 3m

Connects V6 to a barcode reader.

V6-MLT (Cable for Multi-Link 2 master station) 3m

A cable which is used for connecting the V6 master station and the V6 slave
station in the Multi-Link 2 connection.

V6-TMP (Cable for Temperature Controller) 3m
Connects V6 to a temperature controller.

GD-GSB80E (Protection Sheet)

Protects the operation panel surface. Five sheets are included in one
package.

GD-WPS80E (Waterproof Sheet)

Protects the operation panel surface from water.



1 Names of Components 1-7

4 Names of Components

Front Side
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Rear Side
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1. Mounting holes for fixtures @
2. Display
3. Power lamp
4. RUN lamp
5. AC / DC input terminal of power supply
6. RUN/STOP switch
7. CN1: for PLC (RS-232C, RS-422)
8. MJ1, 2: for data transfer and for temperature controller and for barcode reader and for CREC

(option)
9. Dip switches
10. CN2: for printer



1 Dimensions and Panel Cut-out

5 Dimensions and Panel Cut-out

Dimensions of V609E

Unit : mm

@ Bottom View

276

95
85

10

@ Front View
288

203

Panel Cut-out of V609E
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6 Mounting Procedure

Mounting Procedure

1. Cut out the mounting panel (Max. thick: 5 mm) to match the dimensions shown below.

Cut-out Mounting Panel

2774

192%

Panel Cut-out

2. Insert 4 pieces of the fixtures attached to V609E into the mounting holes on V609E. Tighten them with the
locking screws.

Screws 14 pcs
Screw Size :M3
Torque :0.3~0.5 N-m (3~5 kgf-cm) Fixtures
* Never use 6 pieces of the fixtures to mount V609E. @ .
=N Mounting panel

Dimensions of Fixtures Mounting hole

(Unit : mm) Mounting hole

&4{4
1=
e

V609E

Mounting Angle |

The unit (V609E) shall be installed within the angle of ‘
0 to 135 degrees as shown below. 135 ‘

Display
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7 Specifications

General Specifications

Corrosive Gas

Item Type AC Power Supply DC Power Supply
Rated Voltage 100-240V AC 24V DC
Permissible Range of Voltage 85-265V AC (47-440Hz) 24V DC+£10%

:; Permissible Momentary Power Failure within 20ms within 10ms

‘? Demand 40VA or less 20W or less

% Rushed Electric Current 10A, 2ms 24A,10ms

* With-stand Voltage AC external terminals to FG | DC external terminals to FG

: 1500V AC per min. : 500V AC per min.
Insulation Resistance 500V DC, 10MQ or more

= | Ambient Temperature 0C ~+50C

% Storage Ambient Temperature -10C ~+65C

-§ Ambient Humidity 85% RH or less (without dew condensation)

E Dust No conductive dust

é Solvent Resistance No cutting oil or no organic solvent to cling to the unit

o No corrosive gas

Vibration Resistance

Vibration frequency: 10~150Hz, Acceleration: 9.8m/s’ (1.0G)

3 directions of X, Y and Z: one hour

Mechanical
Working
Conditions

Shock Resistance

Pulse shape: Sine half wave,

Peak acceleration: 147m/sz(15G), 3 directions of X, Y and Z: 2 times

1500Vp-p (noise width: 1 us)

Weight

B gé Noise Resistance
§§§ Static Electricity Discharge Resistance Contact: 6kV, Air: 8kV
Grounding Grounding resistance: less than 100Q
Structure Protection structure: front panel complies with IP64
o (when using waterproof screen filter GD-WP80E)
% rear panel complies with IP20
Lg) Form: in a body
_g Mounting procedure: inserted in a mounting panel
é Cooling System Cooling naturally

Approx. 2.1kg

Dimensions W x H x D (mm)

288 x 203 x 95

Panel Cut-out (mm)

277 %5 x 192 7%

Case Color

GREY BLACK

Material

ABS PC/PS
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Display Specifications

ltem Type V609E

Display Device High-intensity EL

Resolution W x H (dots) 640 x 400

Dot Pitch W x H (mm) 0.3x0.3

Effective Display Area W x H (mm) 192 x 120 (8.9 inches)

Color Black/orange-yellow + blinking

POWER Lamp (red) The lamp is lit when the power is supplied.

RUN Lamp (green) The lamp is lit when V6 communicates with PLC normally.

Display Function Specifications

Iltem Specifications
Display Language * Japanese  Eng./W. Europe: Chinese EChinese (simplified) Korean
Characters :1/4-size, 1-byte| ~ ANK code Latin 1 ASCli code}  ASCII code ASClII code

Hangul (without Kanji)

| 2-byte (16-dof) | IS 1st and 2nd
'2-byte (32-dot) | JIS 1st

Size of Chara{cters 1/4-size : 8 X 8 dots

1-byte :8 X 16 dots

2-byte :16 X 16 dots or 32 X 32 dots

Enlarge : W, 1-8 H, 1-8

Chinese : Chinese (simplified)

Number of Characters 1/4-size 80 columns X 40 lines

1-byte 80 columns X 20 lines

2-byte 40 columns X 20 lines

Property of Characters Display property : normal, reverse, blinking, bold, shadow
Color : black/orange-yellow + blinking

Kind of Drawing Lines : line, continuous lines, box, parallelogram, polygon
Circles : circle, arc, sector, ellipse, elliptical arc, elliptical sector

Others : tile patterns

Property of Drawing Type of lines : 6 types (fine, thick, dot, chain, broken, two-dot chain)
Tile patterns : 16 types (incl. user-definable 8 types)
Display property : normal, reverse, blinking

Display color : black/orange-yellow + blinking

Color specification : foreground, background, boundaries (line)

* Concerning Gothic font, use of this font is not recommended since the V609E screen memory capacity
(see the next page) could not be sufficient.
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Function Performance Specifications

Item

Specifications

Screens

Max. 1024

Screen Memory

FP-ROM (flash ROM), Appox. 760kbytes (different from the language)

Switches

192 per screen

Actions of Switch

Set, reset, momentary, alternate, to light
(possible to press a function switch and a display switch at the same time)

Lamps Reverse, blinking, exchange of graphics

192 per screen

* | Pie, bar, panel meter and closed area graph can be displayed without limit.

Graphs Statos and tend arapha: M. 256 pe ayer
© | Numerical Data Display* | No limits, total capacity per screen: within 48 kB
;E Character Display x| No limits, total capacity per screen: within 48 kB
% Message Display * | Resolution : Max. 80 characters
° No limits, total capacity per screen: within 48 kB
Messages 6144 lines
Sampling Sampling display of buffer data

(constant sample, bit synchronize, bit sample, relay sample, alarm function)
Multi-Overlaps Max. 1024
Data Blocks Max. 1024
Graphic Libraries Max. 2560
Patterns Max. 1024
Macro Blocks Max. 1024
Page Blocks Max. 1024
Direct Blocks Max. 1024
Screen Blocks Max. 1024
Temperature Control Network Table | Max. 32
Calendar provided
Hard-Copy provided
Buzzer provided, 3 types (intermittent short, long, continuous beeps)

Back-light Auto OFF Function

ON at all time, specified freely

Self-diagnostic Function

Self-test function of switches
Check function of communication parameter setting
Check function of communication

* Number of the setting memory per screen: 256
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Touch Panel Specifications

Item

Specifications

Switch Resolution

40 (W) X 20 (H)

Form

Matrix resistance film form

Life of Touch Panel

Use of one million times or more

Surface treatment

Hard coating, anti-glare treatment 5%

Interface Specifications

Item

Specifications

Serial Interface
for connecting PLC

(D-sub 25 pins, female)

RS-232C, RS-422/485

Asynchronous type

Data length: 7, 8 bits

Parity: even, odd, none

Stop bit: 1, 2 bits

Baud rate: 4800, 9600, 19200, 38400, 57600bps

Serial Interface 1 and 2 for
transferring data/barcode
/ICREC

(modular jack, 8 pins)

RS-232C, RS-422/485 (2-wire connection)

*When CREC, an optional equipment, is connected:
1 slot
SRAM: Max. 4 MB FROM: Max. 16 MB
Comply with JEIDA Ver. 4.0 (The limit exists.)

Printer Interface

Complies with centronics, half pitch 36 pins (for PC98x1)

NEC : PR201
EPSON : compatibles with ESC/P24-84 or later
HP : PCL Level 3

CBM292/293 printer (The screen copy cannot be printed out.)
MR-400 printer (The hard copy, data sheet and sampling data
cannot be printed out.)

Drawing Environment

Item

Specifications

Drawing Method

Exclusive drawing software

Drawing Tool

oS

Name of exclusive drawing software

Personal computer

Capacity of hard disk required
(For minimum installation

Display

: V-SFT Ver. 1.2.18.0 or later

: Pentium Il 450MHz or more is recommended

: Microsoft Windows 98/NT version 4.0/Me/2000/XP

: free area of approx. 460MB or more
: Approx. 105MB)

: Resolution of 800 X 600 or more is recommended
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8 Wiring of Power Supply

Electrical Wiring

O Connects the cable for power supply to the terminal on the
rear side of V609E.

4 Type: 100-240VAC Type: 24VDC A
L l _+

Power Supply Power Supply
100- - } DC24V ] | 24vDC
240VAC = I +10%
N
@I ne

\ Earth Earth /

Screw Size Torque (N - m) Clamp Terminal (Unit : mm)

M3.5 0.5 (5kgf - cm) s.omx@.: 8.0MAXE-:

O The power source used must be within the allowable voltage fluctuation.

O Use a power source with low noise between the cables or ground and the cable.

O Use as thick a power cable as possible to minimize any drop in voltage.

O Keep cables of 100V AC and 24V DC sufficiently away from high-voltage, large-current cables.

Notes on Usage of 100-240V AC Specifications

O Generally, an isolating transformer improves noise resistance. However, if the display unit is far away from
the secondary port of the transformer and noise gets mixed in, an isolating transformer becomes unneces-
sary.

O If any power voltage fluctuation caused by noise is expected, it is recommended that a voltage stabilizer
(effective in noise resistance) be used.

| Insulation transformer
Power Supply or to V609E
——1 Stabilized transformer
. | /
Groundlng 1.25mn° twisted
A This equipment must be earthed.

O An independent earth pole shall be used for MONITOUCH. (The level
of grounding resistance should be less than 100 Q.)

Other Equipment

O Use a cable which has a nominal cross section of more than 2mm? for
grounding.

O Grounding point shall be near the MONITOUCH to shorten the distance
of grounding wires.

IO 5
I
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9 Serial Connector (CN1)

CNL1 is used for communicating between a PLC and a V609E (RS-232C, RS-422/485).

Interface Specifications

Item Specifications
Serial Interface RS-232C, RS-422/485
for connecting PLC Asynchronous type
(D-sub 25 pins, female) Data length: 7, 8 bits

Parity: even, odd, none
Stop bit: 1, 2 bits
Baud rate: 4800, 9600, 19200, 38400, 57600bps

Serial Connector (CN1) Pin No. | Signal Contents
1 FG Frame ground
The pin arrangement of serial connector is as follows:
2 SD RS-232C send data
3 RD RS-232C receive data
CN1 (Dsub 25pin) 4 RS RS-232C RS request to send
Female 5 cs RS-232C CS clear to send

25 13 p Not used
7 SG Signal ground
8 Not used
9 +5V Use prohibited

14 1 10 ov Use prohibited
11 Not used
12 +SD RS-422 send data (+)
13 -SD RS-422 send data (-)
V609E 14 +RS | RS-422RS send data (+)

15 Not used
16 Not used
17 -RS RS-422 RS send data (-)
18 -Cs RS-422 CS receive data (-)
19 +CS RS-422 CS receive data (+)
20 Not used
21 Not used
22 Not used
23 Not used
24 +RD RS-422 receive data (+)
25 -RD RS-422 receive data (-)
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Wiring for Communication

O Never place the communication cable with electric circuits.
O Never bundle these cables together with other wires in ducts or electric boxes using cord locks. Although it
is tempting to bundle all the cables neatly together, this does not necessarily lead to a noise-resistant

configuration.
O It is recommended that the communication cable be independently wired.

g

Wiring duct

Communication cable Communication cable

\ Power cable and control cable

Power cable and control cable [ I[l

Cord lock

In Case of RS-232C Communication
O In case of RS-232C, SD and SG, and RD and SG form a pair.

O Connect the shielded cable to pin No. 1 or the connector case cover.

V609E (CN1)
To the RS-232C port

Signal Pin No. Sh‘l,e,k,j?fjf?t_)l, ,,,,,,,,,,,,,,,,,,,,,,,, » F),“,héil‘,c,“r,lﬁ{ni
EG I (Y Receive data
SD 2 1 SG

CS 5

‘ |

| |

! \

| |

: i !
OO e |
RS 4 t iSend data !
‘ \

| |

! \

| |

! \

SG 7 — v L B

In Case of RS-422 Communication

O In case of RS-422, +SD and -SD, and +RD and -RD form a pair.

O Use SG if possible.

O Connect the shielded cable to pin No. 1 or the connector case cover.

O Use TC485 or TC609 which is the optional equipment made by Hakko Electronics Co., Ltd. in case of
using terminal blocks in RS-422/485 connection.

O Specify terminal resistance by the dip switches on V6. (Refer to the next page.)

V609E (CN1
( ) To the RS-422 port

Shielded cable of the PLC link unit
I 4 B i e —

Signal Pin No.

FG 1 r~ P

: i
[ ‘
i \
e DD G G M
-RD 25 ! ‘ Send data (+) \
! \
[ ‘
! \
\
\

Receive data (-)

-SD 13 v
SG 7 = > | s6

Receive data (+) i
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Terminal Blocks of RS-422/485
O Connect TC485 (Terminal Converter) which is the optional equipment made by Hakko Electronics Co., Ltd.
to V6 via the serial connector on V609E (CN1) in case of using terminal blocks in RS-422/485 connection.

O The RS-422 signal wiring of TC485 is connected to the serial connector (CN1).
O Specify 4-wire connection or 2-wire connection by the dip switch on TC485 (SW1).
(set to top: 4-wire connection) -

TC485
swi Signal
(Set to top: TC485 (Terminal Converter)
4-wire connection) FG 1
TB1
RD+ — SG 7
L&@]])ro-
so+ | [@8]] +SD 12
== [[@]]||so-
sG -SD 13
FG
+RD 24
-RD 25

Terminal Converter (TC609) for V609E

O To use the existing wiring, used for GD-80E, when replacing GD-80E with VB09E, connect the TC609
(Terminal Converter for V609E), optional equipment made by Hakko Electronics Co., Ltd. to the serial
connector (CN1).

O signal wiring of D-sub 15 pins and RS-422 terminal block of TC609 is connected to the serial connector
(CN1).

O D-sub 15 pin port of TC609 is equivalent to the connector on GD-80E where CPU port direct connection
cable (MB-CPU) for Mitsubishi A/QnA/Fx series is connected. The RS-422 terminal block of TC609 is
equivalent to the RS-422 terminal block of standard specification GD-80E.

* For details, refer to "User's Manual of TC609 (Terminal Converter for V609E)."

TOUOUUT OUDOODT  UUounOD

Top View of TC609

V609E

TC609 (Terminal Converter for V609E)

00080808
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Connection Style
Three kinds of V609E to PLC connection styles are available as shown below.

O1:1 V609E
In this style, a single V609E is connected to a single PLC.
For detalils, refer to "10 1: 1 Communications." | //

To be connected through RS-232C or RS-422 (RS-485) interface.

O 1: n (multi-drop)
In this style, multiple PLCs are connected to a single V609E. (n =1 to 31)

For detalils, refer to "11 1 : n Communications."

V609E

To be connected through RS-422/485 interface
Max. 500 m

O n: 1 (multi-link 2, multi-link)
In this style, multiple V6s are connected to a single PLC.
(Multi-link 2: n = 1 to 4, Multi-link: n =1 to 31)
For details, refer to "12 n: 1 (multi-link 2, multi-link)."

|

\\|| 2

N\ 2
\N

To be connected through RS-485 interface
Max. 500 m

* Connection as show below is not recommended.

z z
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O 1:1 Communications

In this style, a single V609E is connected to a single PLC.

V609E

= e

To be connected through RS-232C or RS-422 (RS-485) interface.

Connectionto a PLC

About the wiring, communication parameter, etc. in connection between V609E and a PLC, refer to ‘Chapter 2
Connection to Link Units’ of “V6 Hardware Specifications.”
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1 1 : n (Multi-drop) Communication

One V6 and multiple PLCs are connected. (n=1to 31)

V609E

Va

Max. 500 m

To be connected through RS-422/485 interface

|

Available PLC for multi-drop communication

Manufacturer

Models

MITSUBISHI ELECTRIC

A series link, QnA series link, QnH(Q) series link, Alink+Net10,
FX series link(A prt)

OMRON SYSMAC C, SYSMAC CV, SYSMAC CS1/CJ1,
SYSMAC CS1/CJ1 DNA

SHARP JW series, JW100/70H COM port, IW20 COM port

Hitachi HIDIC-H

Matsushita Electric Works

MEWNET

Yokogawa Electric

FA500, FA-M3, FA-M3R

Yaskawa Electric

MEMOBUS, CP9200SH/MP900

Toyoda Machine Works

TOYOPUC

Fuji Electric

MICREX-F series, FLEX-PC series, FLEX-PC COM(T)

KOYO ELECTRONICS

SU/SG, SR-T

Allen-Bradley PLC-5, SLC500, Micro Logix 1000
GE Fanuc 90 series

TOSHIBA T series

Siemens S7-200 PPI, S7-300/400MPI*
SHINKO ELECTRIC SELMART

SAMSUNG SPC series, N_plus, SECNET
KEYENCE KZ series link, KZ/KV series CPU
LG MASTER-K500/1000, MASTER-KxxxS CNET, GLOFA CNET
FATEK AUTOMATION FACON FB series

IDEC MICRO3, MICRO Smart
MODICON Modbus RTU

TAIAN TPO2

Universal Serial

*Up to 4 PLCs can be connected.




1 1:n (Multi-drop) Communications

1-21

Multi-drop Communication (RS-422)

Refer to the PLC manual of each manufacturer for connection.

<E.g.>

The following example describes how one V609E is connected to three PLCs made by MITSUBISHI.

See MITSUBISHI's manual for further details.

V609E (CN1) Link unit Link unit Link unit
Signal [Pin No. Signal Signal Signal
e | 1| i e | AR e | AR Re
+sp | 12— *—{ RDA | - roa RDA
-sp | 13 f——+—+—— RDB | RDB RDB
+RD | 24 SDA {— SDA i~ SDA
RD | 25 i+ 1 sps — spB [— SDB
s | 7 '," ".‘ '," SG s —H—H— sc

.......... L, I

SD/RD terminal resistance

ON
N * Use twist shielded cable.
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17 n: 1 (Multi-ink 2, multi-link)

Multiple V6s are connected to a single PLC.
In this style, there are two kinds of communications.

n:1Link Communication (Multi-link2)

O Up to 4 units can be connected to one PLC.

* Between a PLC and the V6 master station is the same as those for 1:1 communication.

PLC

Communication between the stations : RS-485 (2-wire system) Maximum length: 500 m

@ L ® [§]© : ©) © ‘
oni] [maz] “& [Nt CNL CNL
V6 master V6 slave V6 slave V6 slave
(Station 1) (Station 2) (Station 3) (Station 4)

O Available PLCs for multi-link2.
As of December 2003, the PLCs su
cation will be supported.

pported are as follows. All the PLCs which are usable for 1:1 communi-

Manufacturer

Models

MITSUBISHI ELECTRIC

A series link, A series CPU, QnA series link, QnA series CPU,
QnH(Q) series link, QnH(A) series CPU, QnH(Q) series CPU,
Q00J/00/01 CPU, FX series CPU, FX2N series CPU,

FX1S series CPU, FX series link(A prt)

OMRON SYSMAC C, SYSMAC CV, SYSMAC CS1/CJ1
SHARP JW series, JW100/70H COM port, JW20 COM port
Hitachi HIDIC-H, HIDIC-S10/2alpha, HIDIC-S10/ABS

Matsushita Electric Works

MEWNET

Yokogawa Electric

FA500, FA-M3, FA-M3R

Yaskawa Electric

MEMOBUS, CP9200SH/MP900

Toyoda Machine Works

TOYOPUC

Fuji Electric

MICREX-F series, MICREX-F series V4, FLEX-PC series,
FLEX-PC CPU, FLEX-PC COM(T), FLEX-PC series(T),
FLEX-PC CPU(T)

KOYO ELECTRONICS

SUISG, SR-T, SR-T(K prt), SU/SG(K-Sequence)

Allen-Bradley PLC-5, SLC500, Micro Logix 1000, Control Logix

GE Fanuc 90 series, 90 series(SNP-X)

TOSHIBA T series, EX series

TOSHIBA MACHINE TC200

Siemens S5, S5 PG port, S5 V4, S7, S7-300MPI(HMI ADP),
S7-300MPI(PC ADP), S7-300MPI(Helmholz SSW7 ADP),
T1500/505, TI500/505 V4

SAMSUNG SPC series, N_plus, SECNET

KEYENCE KZ series link, KZ-A500 CPU, KZ/KV series CPU, KZ24/300 CPU,
KV10/24 CPU, KV-700 CPU

LG MASTER-K10/60/200, MASTER-K500/1000, MASTER-KXXXS,
MASTER-KxxxS CNET, GLOFA CNET, GLOFA GM series CPU

FANUC Power Mate

FATEK AUTOMATION FACON FB series

IDEC MICRO3, MICRO Smart

MODICON Modbus RTU

Yamatake MX series, DMC50

TAIAN TP02
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For the I/F driver, the Multi-Link 2 is supported by the version of 1.100 or later and as for a V6 master
station, make sure the hardware version of the unit is as follows. As for V609E/V606/V606i, any version

can be used.
- Analog type: V612T --> D, V612C --> C, V610S --> D, V610T --> D, V610C --> C, V608C --> F

- Matrix type : All version

*When V609E (or V606/V606i) is used as a master, V6 models that can be connected as a slave are only V609E,

V606 and V606i.
* The Multi-Link 2 cannot be used in Temperature control network.

O Up to 4 units can be connected to one PLC.
Use the terminal converter (TC485), the optional equipment made by Hakko Electronics Co., Ltd.

See Multi-link2 manual for further details.
* Wire the shielded FG only at the one of both sides so that they are not connected.

* Set the dip switch (SW1) of TC485 as 2-wire connection when the TC485 terminal converter is used.

(b) (] | (d) (e)
V6 master Terminal block V6 slave V6 slave V6 slave
MJy1/2 prepared by user CN1+TC485 CN1+TC485 CN1+TC485
Signal Signal Signal Signal
------- - - FG FG - 1 FG
ot e e R0
Lo Lo ; i | -sp ; -SD A -SD
et i il se '," '." SG '." ,," SG - 5 SG
Terminal resistor Terminal resistor Terminal resistor Terminal resistor
(ON) (OFF) (OFF) (ON)

« Short-circuit between +RD and +SD, and -RD and -SD when the TC485 terminal converter is not used.
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n:1Link Communication (Multi-link)
O Multiple V6 and a PLC are connected. (n=1 to 31)

Vi

\\||

Z

Max. 500 m

O Available PLCs for multi-link

To be connected through RS-485 interface

* Connection as show below is not recommended.

z

z

z

Manufacturer

Models

MITSUBISHI ELECTRIC

A series link, Alink+Net10, FX series link(A prt),
QnA series CPU (with V-MDD)

SHARP JW series, JW100/70H COM port, JW20 COM port
Hitachi HIDIC-H

Matsushita Electric Works [ MEWNET

Yokogawa Electric FA500, FA-M3, FA-M3R

Toyoda Machine Works TOYOPUC

Fuji Electric MICREX-F series, FLEX-PC COM(T)

TOSHIBA T series

TOSHIBA MACHINE TC200

Siemens S7-200 PPI, S7-300/400MPI*

SHINKO ELECTRIC SELMART

SAMSUNG

SPC series, N_plus, SECNET

LG

MASTER-K500/1000

* Up to 3 units can be connected to one PLC.
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O When multiple V6 are connected to a link unit of PLC, use the terminal converter (TC485), the optional

equipment made by Hakko Electronics Co., Ltd. for RS-485 connection.

V6+TC485 V6+TC485 V6+TC485 Link unit

Signal Signal Signal Signal
FG FG FG FG
+SD +SD +SD +RxD
-SD -SD -SD -RXD
+RD +RD +RD +TxD
-RD , i | -RD i i | ro -TXD
SG SG SG : SG

RD terminal resistance

oN

[ &

[ &

RD/SD terminal resistance

(OFF)

* Use twist shielded cable.

(OFF)

RD/SD terminal resistance

Set the dip switch (SW1) of TC485 as 2-wire connection when the TC485 terminal converter is used.

Short-circuit between +RD and +SD, and -RD and -SD when the TC485 terminal converter is not used.

O When multiple V6 are connected directly to MITSUBISHI's QCPU port, the optional equipment, V-MDD is
required. Make sure to use V-MDD GD port. (Itis recommended to use “TC485 Terminal Converter”

which is an optional equipment made by Hakko Electronics Co., Ltd..)

» Set the dip switch (SW1) of TC485 as 2-wire connection when the TC485 terminal converter is used.

V-MDD
V6+TC485 V6+TC485 V6+TC485 GD port
Signal Signal Signal Pin No.| Signal
FG f— FG C— FG 1
+SD ‘ +SD +SD 2 | +RxD
-sD — -sD -sD 3 | +Tx0
+RD +RD +RD 4 +DSR
-RD i | rD ; i | RO 5 |+DTR
SG - - ': SG : SG 7 SG
RD terminal resistance RD/SD terminal resistance RD/SD terminal resistance 15 | -RxD
(ON) (OFF) (OFF) 16 | Tx0
* Use twist shielded cable. 17 | -DSR
18 -DTR
20
21

Short-circuit between +RD and +SD, and -RD and -SD when the TC485 terminal converter is not used.
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3 Modular Jack 1 & 2

Modular Jack 1 & 2 (MJ1/2) MJ1/2 Pin No. f;g*;;:)

-SD/RD
+5V
+5V Output power supply

ov Max. 150mA

oV
RD
SD

The right diagram is the pin arrangement and the
signal name of modular jack 1 & 2.

12345678

L

O N[OOI~ W|IN|-

Setting of Modular Jack 1 & 2 (MJ1/MJ2)
O Specify the use of MJ1/MJ2 by the software (V-SFT).

O Select [Modular] of [System Setting], and then the [Modular Jack] dialog is displayed. The setting items of
[Modular Jack 1] and [Modular Jack 2] in this dialog are as follows.

Modular Jack 1 Modular Jack 2
[Editor port] [Not used]
[Memory Card] [Memory Card]
[Barcode] [Barcode]
[V-1/0] [V-1/0]
[Multi-Link] * [Multi-Link] *
[Temp./ PLC2Way] [Temp./ PLC2Way]
[V-Link] [V-Link]
[Modbus Slave] [Modbus Slave]
[Printer(Serial Port)] [Printer(Serial Port)]

It is impossible to select both [Multi-Link] and [Temp./ PLC2Way] in each setting of modular jack.

* It is possible to select this item when [Multi-Link 2] is selected for [Connection] and [Local Port] is set to [1] in
the [Comm. Parameter] dialog.

Editor Transferring

O Use modular jack 1 (MJ1) in case of editor transferring.

O When [Editor port] is selected for [Modular Jack 1] in the [Modular Jack] dialog, it is also possible to
transfer the data while running, because the auto change of the local mode and the run mode is valid.

When [Editor port] is selected, on-line editing and the simulation mode are also available.

O When the item other than [Editor port] is selected for [Modular Jack 1] in the dialog, be sure to transfer the
data by the software in the local mode. On-line editing and the simulation mode are not available.

O When the data is transferred by software, use the cable for data transferring which is the optional equip-
ment made by Hakko Electronics Co., Ltd. (V6-CP: 3m) to connect V609E to a personal computer.
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4 Setting of Dip Switches

Setting of Dip Switches

BBBB B

Terminal resistance of MJ2 (modular jack 2)
RD terminal resistance of pin No. 24 and 25 in CN1

Not used
Terminal resistance of MJ1 (modular jack 1)

O Setting of Terminal Resistance
* Set DIPSW 7 ON in case of connecting V6 to PLC by RS-422/485.

* Set DIPSW 6 (DIPSW 8) ON in case of connecting with Modular Jack 1/2 by the connection as shown
below.
Multi-link 2 communication (master)
Temp./ PLC2Way communication by connection of RS-485
Card Recorder : CREC (option) is used
Serial Extension 1/0O : V-1/O (option) is used
Terminal V609E connected with V-Link by connection of RS-485

O Keep DIPSW 1, 2, 3, 4, 5 and 8 (not used) OFF.
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5 Barcode Reader Interface

O Itis possible to receive the signal from a barcode reader by connecting a barcode reader to V609E via the
modular jack (MJ1/MJ2) of V609E.

O To connect a barcode reader to V609E via MJ1/MJ2, use the cable which is the optional equipment made
by Hakko Electronics Co., Ltd. (V6-BCD).

Length :3m

12345678

Brown : +5V

Red : OV >
Orange : RXD

Yellow : TXD

© Notes on Connection
* In case of using the barcode reader which uses the CTS and RTS control, the barcode reader may

not work normally without jumping RTS and CTS.
* The output power supply (+5V) is max. 150mA. (Refer to page 1-26.)

O When the barcode reader connected to GD-80E is used, connect it to V609E by the following cable.

-

12345678

Barcode Reader D-sub 9pin ()
Signal Pin No. | Signal

RTS 1 CTS =

TXD 2 RXD range|: RXD

RXD 3 TXD Yellow[: TXD

CTS 4 RTS

SG 5

+5V \ 6 * Jump pins, 1(CTS) and 4(RTS).
7 SG Red : OV
8
9 +5V Brown : +5V
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6 Printer Interface (CN2)

O When a printer is connected to V609E via the connector (CN2), it is possible to hard-copy the screen
display of V609E, the data sheet, or the sampling data.

O To connect a printer to V6, use the parallel interface cable of 36 pins which is optional equipment made by
Hakko Electronics Co., Ltd. (V6-PT: 2.5m)
When using CBM292/293 printer, our printer cable “V6-PTCBM” is available.
* The printer cable for GD-80 or V4 cannot be used.

'

Centronics

to Printer

Half pitch 36 pins

O Compatible Printer Control Code System and Printer Models
NEC PC-PR201 series

EPSON Compatibles with ESC/P24-84 or later
HP(HEWLETT PACKARD) PCL Level 3

CBM292/293 Line thermal panel printer made by CBM Corporation
(The screen copy cannot be printed out.)
MR400 Barcode printer [MR400 series] made by Sato Corporation

(The hard copy, the data sheet, and the sampling data cannot be
printed out.)

Note of Usage of SRAM Memory Card (via CREC);

In case of connecting a printer to V609E with a “REC-MCARD(Memory Card:SRAM)” at all times, be sure to
turn off a printer at the same time when turning off V609E. If a printer is not turned off when V609E is turned
off, the voltage will circulate from the power supply line of a printer to make the power consumption of SRAM
cassette’s backup battery increase, and finally, the backup battery will consume drastically within a few
months.
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Specifications of SRAM &
Built-in Clock

Memory Specifications

Item Specifications
Memory Type SRAM
Memory Capacity 8kbytes

Backup Specifications

Item Specifications
Battery Specification Lithium primary battery of coin type
Battery model : CR2430 (SANYO)
Backup Period 5 years (at the temperature of 25°C)
Replacement Available (battery is attached to a socket)

Detection of Voltage for Battery Lowering | Available (internal memories allocated)

Calendar Precision | Remainder on a month +90 seconds (at the temperature of 25°C)

Notes on Usage of SRAM & Clock Function

O Check if the battery is set when using SRAM or clock function. The contents of SRAM may not be
maintained if the electric power for SRAM is cut off.
(The factory-shipped configuration is with the battery set.)
Refer to the next item, “How to Check the Battery,” about the way to check the battery condition.

O Use the following versions of each program file:

V-SFT version 1.3.1.0 or later
System program version 1.510 or later
Font data version 1.210/1.140/1.000 or later

[Caution seal]

How to Check the Battery

The battery is set in V609E30M when shipped from the
factory.

The standard backup period (5 years) is written down in
the section of the ‘Battery replacement’ of the caution
seal on the rear side of V609E30M.

See operating or maintenance

instruction for type of

battery to be used.

BOEC LT A REHAE

EBMLTT AL

Battery replacement,
BFE

The date after 5 years is
written down when shipped
from the factory.

*The life of battery for V609E30M is about 5 years at
25°C. Even if 5years don't pass, when the battery
voltage has dropped, bit 4 of $s167 is set (ON) to give an alarm about battery replacement. Replace the battery
immediately then.

MSB LSB
15 (14 (13 (12 |11 |10 |09 |08 |07 |06 |05 |04 | 03 | 02 | 01 | OO
$s167
ojojojojofojofjojo|oO 0|0
— 0: SRAM & clock not attached
(= V609E10Mx used)
3: SRAM & clock attached

Memory cassette information reservation (= V609E30M used)
(setting: 0)

L—Memory cassette information reservation (setting:0)

1: Battery error (replacement necessary)
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How to Set SRAM and Clock

O How to Set SRAM
Make sure if the battery is set before starting the following procedures.

1. Specify the necessary setting of the [SRAM/Clock Setting] in the [System Setting] when editing the
screen data file.

2. Transfer the screen data file to V609E.

3. Pressing the [SRAM/Clock] switch of the [Main Menu] screen to the [SRAM/Clock Adjustment] screen,
and execute the format of SRAM.

After that, the area of SRAM in V609E30M is to be available.

O How to Set Clock
Make sure if the battery is set before starting the following procedures.

1. Check [Use Built-in Clock] of the [SRAM/Clock Setting] in the [System Setting] when editing the screen
data file.

2. Transfer the screen data file to V609E.

3. Pressing the [SRAM/Clock] switch of the [Main Menu] screen to the [SRAM/Clock Adjustment] screen,
and set the calendar.

After that, the clock function in V609E30M is to be available.

Replacement of Battery

© Safety Precaution for Handling a Battery
The lithium battery encloses inflammable materials such as lithium and organic solvent. Therefore,
wrong handling of the lithium battery may cause personal injury or fire. Thoroughly pay attention to the
following cautions when handling the lithium battery to prevent unintended accidents.

4 A CAUTION h

- Be sure and discharge the build-up of static electricity before installing, inspecting and maintaining the
product.

- When replacing a battery, be sure and use the same battery as mentioned above. Use of another
battery may prevent a risk of fire or explosion.

- The battery used in this device may present a fire or chemical burn hazard if mistreated.

- Do not disassemble, heat or incinerate the battery.

- When scrapping the spent battery, insulate the terminals with applying tape to them and follow local
ordinances or regulations for its disposal.

- Keep away the battery from children. (Please immediately consult with a doctor if children have
swallowed the battery.)

- Do not short-circuit.

- Do not charge.

- Do not solder directly on to batteries.

- Do not use the battery with the direction of +/- reversed.

- When the battery is leaking or giving out a foul smell, keep away the battery from fire right away,
because there is the danger that the leaking electrolysis liquid is caught fire.
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© safety Precaution for Handling V609E in Battery Replacement
Understand the procedure described in this manual before replacing the battery. Hakko Electronics
assumes no responsibility for any accidents caused by failure to follow the replacement procedure in

this manual

-

@ DANGER

~

.

- Turn off V609E before attempting to replace the battery. Set V609E aside until it cools. Failure to do
so may result in an electric shock or burns.

J

-

A CAUTION

~

\_ in failure.

- Wear gloves or fingerstalls when replacing the battery.
- Take necessary measures to protect V609E from static electricity.
- Do not touch cables and boards that are not associated with battery replacement. Doing so may result

)

O How to Replace Battery
The battery for replacement is prepared.

Name Model Composition
V609E Battery for | VEEM/RB | . Lithium primary battery of coin type 1 pce
Replacement (SANYO CR2430)
- A seal for caution 1 copy

V609E can maintain the data in SRAM when the battery is replaced within 3 minutes after removing the

original battery.

If it takes 3 minutes or more to replace the battery, save the data in SRAM by using V-SFT (cable: V6-CP)

as follows.

1. Start the V-SFT.

2. Click the [Transfer] icon. The [Transfer] dialog is displayed.

3. Choose [Display] for [Transfer Device], and [SRAM Data] for [Transfer Data].

4. Click [PC<-] under [Transfer Mode].
5. The read data is to be stored in the “*.RAM" file.

Replace the battery as follows:

1. Turn off V609E, and turn it upside down as follows. Remove the 4 external screws.

Remove
the screws.

Aplace it on a cloth, etc. to protect the display panel from scratches.
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2. Remove the rear external case softly according to the following direction to show the internal PC board.

Front external
case

Remove the rear

Rear external
external case softly.

case

2 Do not remove the cables connecting the front case to the rear case.

Doing so may result in failure.

3. Disconnect the battery from the connector.
Remove the battery at the side of © in the battery connector by pressing it in the direction of the @ side.

© side

Battery

@ side

4. Replace it with a new one.
Set the battery with the ® side upward. When setting the battery, put it at the side of @, and then, put it in
the © side by pressing it in the direction of the ® side.

5. Close the rear case of V609E.
6. Attach the 4 external screws.
7. Remove the caution seal from V609E.
Write down the date after 5 years in the section of the

replacement date of the caution seal, and put up the seal on
the rear of V609E.

8. Turn on V609E.
Transfer the RAM file in the case of saving it before the replacement.
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1. Operation of Main Menu
2. Errors Caused on the V609E
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1 Operation of Main Menu

When the power of V6 is turned on for the first time, the screen on the below left is displayed. After transfer-
ring the screen data to V6, the following "Main Menu" is displayed.

When power is turned on for the first time: "Main Menu" after transferring data
'd ~\ 'd
— - V609E3OM 1998-5-5 9: 0: 20
Transfer the screen data. =
Wi =
b #EglolelE WEHTUAR I}
7
A\ J A\

If the screen data has been already transferred to V6, press the [RUN/STOP] switch on the rear side.
The [Main Menu] is displayed.

RUN/STOP switch
on the rear side

"Main Menu" after transferring the screen data

( N
VG09E3OM 1998-5-5 9: 0:20
|svs PROG.VER 1.430 | ores |
|FONT VER.1.210/1.100/1.000 |
JAPANESE 32
lcomm.para]
I/F DRV VER.1.200
MELSEC AnA/N/U
PLC Type - MITSUBISHIANAINIU series —
| Comment SRAMICIocd
POWER
o
RUN
o
EditorMJL
p J
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Main Menu

The "Main Menu" is the system menu for transferring the data between a personal computer and V6.
When the screen data is transferred from a personal computer to V6, the "Main Menu" or “Comm. Parameter”
(see page 2-10) must be displayed.

(If [Editor port] is selected for [Modular Jack 1] in the [Modular] of the editing software, it is not necessary to
display the "Main Menu.")

System Program version Model name of V609E
\ /
( \ / \
AY 7
\ 7
Main Menu \ V609E30M 1998-5-5 9: 0: 20
v —_— 1.
- SYS PROG.VER.1.430 | | —
Font data version | | —
\_\+FONT VER.1.210/1.100/1.000 | I 2.
JAPANESE 32 —————
. [Comm.Para T
PLC I/F driver I/F DRV VER.1.200 3.
version and name /—/’ MELSEC AnA/N/U
[

PLC Type : MITSUBISHIANA/N/U series |

Comment : I RAM/Clock] 4,
POWER
(=]
RUN
(=]

Editor:MJ1

\

\\ I

J
\

PLC type and comment
specified by the panel editor

1/0O Test

When the switch '1." on the "Main Menu" is pressed, the following "I/O Test" is displayed.
This is the test menu to check only V609E hardware.

D
/
( / ~N
/I
1/0 Test Im
[Printer Cheef B
[[gerial Test || [Bwitch CheH
POWER
=
RUN
=)
I AY
& / \ J
! \
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A. Self-loop Test

Pressing the switch ‘A’ on the “I/O Test” brings to the [Serial Test] screen.

This is the test menu to check the signals necessary for V6 to communicate with PLC or a personal computer
by using only V6.

( )

Serial Test | ]

Self-Loop Test
Please refer to the manual, "Hardware Specifications".

Communication Port

|

[Cov ]| |[Re2ezc ]

POWER
=]

RUN

<> Signal Test of RS-232C in CN1
Select [CN1] and [RS-232C] in [Communication Port] by pressing each switch.

m W Communication Port
CNL

| |
o || [

@ Loop-back Test
Check the [SD] and [RD] signals.
1. Jump pins, 2 and 3 of CN1.
2. The test is OK, if the [OK] lamp turns on when the [Self-Loop Test] switch is pressed.

communication Port Communication Port

Al
e T =

[ | |

* If the [NG] lamp turns on when the same switch as above is pressed, ask the advice of your distributor.
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@ Test of CTS/RTS
Check the [CTS] and [RTS] signals.

1. Jump pins, 4(RTS) and 5(CTS) of CN1.
2. The test is OK if the [CTS] lamp and the [RTS] lamp turn on at the same time that the [RTS] switch is

pressed. Similarly, the test is OK if the [CTS] turns off at the same time that the [RTS] is turned off.

<> Signal Test of RS-485 in CN1
Select [CN1] and [RS-485] in [Communication Port] by pressing each switch.

m Communication Port
wee Ll
I el-Loop I

@ Loop-back Test
Check the [SD] and [RD] signals.
1. Jump each pin, 12 and 24, 13 and 25 of CN1.
2. The test is OK, if the [OK] lamp turns on when the [Self-Loop Test] switch is pressed.

CN1 I RS232C I . CN1 RS232C
—> | L
[ a2 ] Selfioop ] wz

Communication Port ,_l Iﬁ Communication Port
CTS RTS
\

|

RS485

* If the [NG] lamp turns on when the same switch as above is pressed, ask the advice of your distributor.
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@ Test of CTS/RTS
Check the [CTS] and [RTS] signals.
1. Jump each pin, 14(+RTS) and 19(+CTS), 17(-RTS) and 18(-CTS) of CN1.
2. The test is OK if the [CTS] lamp and the [RTS] lamp turn on at the same time that the [RTS] switch is
pressed. Similarly, the test is OK if the [CTS] turns off at the same time that the [RTS] is turned off.

<> Signal Test of RS-232C in MJ1 and MJ2
Select [MJ1] (or [MJ2]) and [RS-232C] in [Communication Port] by pressing each switch.

m W Communication Port
o ==
Ce0) o) |6 =]
§eT1ﬁE° Op I MJ2
@ Loop-back Test

Check the [SD] and [RD] signals.
Execute the test by connecting the data transfer cable (V6-CP) to CN1.

1. Set the adaptor, ADP25-9, which is attached to V6-CP, to V6-CP. And connect the modular jack side

of V6-CP to MJ1 (or MJ2), ADP25-9 side of V6-CP to CN1.
V6-CP

(b@ => MIL/2

Communication Port TS RTS Communication Port
O =1 = == == | |
[ | (=

* If the [NG] lamp turns on when the same switch as above is pressed, ask the advice of your distributor

<> Signal Test of RS-485 in MJ1 and MJ2
When you execute the signal test of RS-485 in MJ1 and MJ2, ask the advice of your distributor.
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B. Printer Check

Check the signal of printer.

The test is OK if the test printout is executed satisfactorily when connecting V609E to a printer and pressing
this [Printer Check] switch (B).

1"#$%8&@ 0123456789 ABCDEFGHIJKLMNO
"#$%8&@ 0123456789 ABCDEFGHIJKLMNO
"#$%&@ 0123456789 ABCDEFGHIJKLMNO
1"#$%8&@ 0123456789 ABCDEFGHIJKLMNO
"#$%8&@ 0123456789 ABCDEFGHIJKLMNO

1"#$%&@ 0123456789 ABCDEFGHIJKLMNO
"#$%8&@ 0123456789 ABCDEFGHIJKLMNO

C. Switch Check

Check the reaction of the touch switches on the V609E panel.

When the [Switch Check] switch (C) is pressed, the following screen is displayed.
Confirm that the color of the pressed area changes into orange-yellow.

The orange-yellow color means that the switch reacts to the touch normally.
Pressing the corner right below [*] leads to the previous [I/O Test] screen.

[Brinter Chec]

==
13)
| —
J/ A J/
1000
OO0
If the pressed area is
reversed, these switches
reacts to the touch normally.
D. Main Menu
Pressing this [Main Menu] switch (D) leads to the previous [Main Menul].
N e A
— o] Ve S 50w
— -
— SAane: 5
|:|'> ESe
e | e Commme 1B SHATANIY seres
| —
| J
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Memory-Card

When the [Memory-Card] switch (2.) on the "Main Menu" is pressed, the following "Memory-Card" is dis-

played.
This screen is to transfer the screen data between V609E and a memory-card.
e N
Memory-Card
Port Selection Transfer
M1 Display <-- Card I
Data Selection M
Screen Data I Diselaz <-> Card I
|/F Driver I Start I
T
POWER
(=]
RUN
(=]
\ J

@ Procedure of Data Transferring

1) Port Selection

Select the [Modular Jack MJ1] switch (or [Modular Jack MJ2]) in case of using a modular jack.
When each switch is pressed, the “Memory-Card Information” window is displayed.
Pressing the “Close” switch leads to the original screen after checking the memory card information.

-
Memory-Card
Port Selection Transfer
Display <-— Card |
a9 "\ \ Display --> Card
|ICScreen! Display <> Card
1/ Start
Font Data Cancel
|
Sys Program
POWER
[=]
RUN
[ =]
.

-
Memory-Card Fein viend]|
Close.
Memory-Card Information (2]
Sys Program : j
N~
Font Data
- /-
I/F Driver j
VERSON:-.--
Screen PLC Type
Screen Comment
POWER
=]
RUN
o
(.

* In case of selecting [Card Recorder] from [Modular Jack 2] on V-SFT and transferring data, it is possible to
select the [Modular Jack 2] switch in the [Port Selection] menu of the [Memory-Card] screen on V6.
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2) Data Selection, Transfer

Pressing each switch leads to selection of the target for data transferring. (Possible to select multiple
items.)

Data Selection Transfer

Memory-Card

Memory-Card

Transfer
[ Display <-—Card |

Data Selection

[ Screen Data |
/F Driver

Font Data

POWER POWER
-] -]
RUN
o

RUN
o

3) Start

When the [Start] switch is pressed, the data transferring starts. During data transfer, the character, the
lamp of ‘Start’ switch is turned ON.

After transferring data, the following message is displayed. Press the [OK] switch.

Start transferring

During transferring

N s
Nemory Card Nemory-Card
[vain vend] Main Menj
Port Seleciion Transter Port Selection Transter
= (o=
Data Selection Data Sefection || I2ERE
[Screenbaa || [CScreen bata | Display <-> Card
[CFomer o J| > _
———\
PouER powEr
- | -]
Ry o
-] -]
J §

Finish transferring

Memory-Card

Work normally finished

POWER
-]
RN
(-]
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L 4 Message Display in Data Transferring

If an error occurs during transferring data, the message display Work normally finished

window shown on the right is displayed. The kinds and the contents

of the messages are as shown below.

[ ox |

Message

Contents

Work normally finished.

The specified operation has been concluded normally.

CREC not connecting

CREC is not connecting when selecting a modular jack.

CREC Communication Error

A communication error occurred between V6 and
CREC when selecting a modular jack.

Memory-Card not setting

A memory card is not inserted.

Memory-Card Capacity over

Cannot write the data into a memory card because
the data size in V6 is larger than the capacity of
a memory card.

Write Protect : ON

Cannot write data into a memory card because
the write protect switch in a memory card is ON.

Writing Error occurred.

The error occurred while writing data into a memory
card.

Selected data does not exist.

The data in the reading target does not exist.

V6 type is different.

The specified type of the data in V6 is different from the
type of the memory card data.

Selected data can not be read.

The data in a memory card cannot be read.

Reading Error occurred.

The error occurred during writing data into a flash
ROM of Vé.

Data discrepant

There is some discrepancy in data, when comparing data
between a memory card and V6.

Screen data on V6 will be broken.

This message appears to inform the user that the data in
V6 will be broken by transferring the font data (the size
which is larger than the present data) from a memory
card to V6. (The [OK] switch continues the transferring.
The [Cancel] switch stops transferring.)

Undefined Error occurred.

The error occurred due to some cause other than
the above mentioned.
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Comm. Para.

When the [Comm. Para.] switch (3.) on the "Main Menu" is pressed, the following "Comm. Param." is

displayed.

This screen is to show the setting of communication parameter of V609E.

-

VG09E30M 1008 55 9 0.20

'SVS PROG.VER 1430
FONT VER.1210/1.100/1.000
JAPANESE 32

F DRV VER1.200
MELSEC AnAINIU

70 Tost

PowER
]
RUN
o

N

SRAM/Clock

-

POWER
o

RUN
=

‘Comm. Param.

Screen Data Size : 786432

Connection:
ignal Level

sig
PLC Stal. No,

11 Baud Rate:19200
RS232C Data Length:7
00

When the [SRAM/Clock] switch (4.) on the "Main Menu" is pressed, the following "SRAM/Clock Adjustment”

screen is displayed.

This screen is to adjust the V609E built-in clock, and format the SRAM area.

199555 9 0.20

Main Menu VG09E0M

SYS PROG VER 1430

FONT VER.1210/1.100/1.000
JAPANESE 32

F DRV VER.1200
MELSEC AnAINIU

PLC Type : MITSUBISHIARAINIU seres
Comment

PoweR
=
Run
=

10 Test

¢ Data and Time Adjustment

POWER
]
RUN
o

[SRAWIClock Adjustment]

1008-5-5 9 0:20

Date and Time Adjustment

Date: 1998- 5- 5
Time: 9: 0: 20

HEEE

[Ltzin viend

Format of SRAM
* Formats SRAM cassette in the present screen data type.

= =1

1) Move the cursor by using [->] or [<-] switch, and then use [+] or [-] switch to adjust both date and time.
2) Press the [Set] switch after adjusting both date and time.

3) Both of them are displayed in the time display located above.

@ Format of SRAM

Format of SRAM makes the data which is currently stored in the SRAM erased. Whenever you try to
format the SRAM area, take note about this and perform the format carefully.

1) First, press the [Format] switch, and then do the [Execute] switch.
The format of SRAM is performed in the present screen data type.

2) The [** Format Completed **] message appears after the format of SRAM is performed successfully.
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2 Errors Caused on the V609E

Communication Error

The followings are the errors which are often caused on the V6 series.
About any other errors except these errors, refer to ‘Appendix 3 Error’ in “Reference Manual (Function).”

* When you go to [Comm. Parameter],

required amount of time.

h bring up the [Detail] tab window and
set [Continuous] for [Comm. Err.
Handling], a screen like the one
Communication Error shown below is displayed.
Time-Out
Screen No. : Receive No.:
IEEEA ™
: T~ This portion of the
message changes.
L e ) |
Message Contents Solution Remarks
Time-Out * Although a request is 1) Check the communication parameter. A
sent for transmission to | 2) Check the cable and wiring. | |
the PLC, an answer is 3) Data may be disrupted because of
not returned within the  [noise. Fix noise. B

Error code received

An error code was sent
to the link unit by the
CPU of the PLC.

Solve the problem by examining the
CPU error code.

Check I/F driver
(applicable to I/F
driver for Simulator)

When sending a com-
munication request to a
personal computer
(simulator), there is no
reply from a personal
computer.

If a simulator is not used, transfer the
I/F driver for PLC again.

* | the above error messages are displayed on the V609E without establishing
communication between V609E and PLC, test the solution of remark "A."
If the error occurs suddenly in communication, test the solution of remark "B."
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System Error

When a system error is detected, the following error screen is displayed.

SYSTEM ERROR : 32

Error : XX

11
30
31
32
33
34

35

: Watch dock timer error
: Switch table error
: Request for displaying full error
: Memory allocation system error
: General exceptions/MMU address system error
: RTOS system error
: Memory error
(when detecting an error by self-check of RAM)
: Inaccurate memory error
(when detecting an access to a memory of an inaccurate memory model,
e.g. PLC or internal memory etc.)

The source of the error could be one of the following three problems. Contact the technical support depart-

ment of your distributor.

1) Program crash due to noise
2) Hardware problem

3) Bad program

Others

About any other errors except one in this chapter, refer to ‘Appendix 3 Error’ in “Reference Manual (Func-

tion).”
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1 Screen Editing of V609E

V609E is developed as a higher-level model that replaces GD-80E (Monitouch GD series of EL display type).

Concerning the items to be taken into consideration when converting the GD-
80E data to V609E screen data, refer to “2 GD-80E --> V609E Conversion.”

The following describes the procedure for newly creating the screens using V609E.

Setting Procedure

A new V609E screen will be created according to the following procedure.

1. Start V-SFT, and click the [New] icon, or select [New] from the [File] menu.

@V Series Editor for Wi
@\f Series Editor for Yindow File

iz (D1 ew D)
| ”G|EI{=§|\ Or @@en...

KO Transfer...
Send AT command. ..

2. The [Edit Model] dialog is displayed.

Select [V609E (640*400 8.9 inches)], then click [OK]. x
Edit Model
VEDIE (B40°400 8.9 inches| =l

WF125 (B00°E00)
w7105 (B007600]
WFIOT (G407480]
w7085 (00600
W70AC (6407480]
WETZ [800°60012.1 inches]
WE10S (800600 10.4 inches)
WEID [640°460 10.4 inches]
WEODG (6407480 7.7 inches]
WEOE [320°240 5.7 inches]
WEOGI (3207240 5.7 inches|
WEOEe (3207240 5.7 inches)
WENBCH(E40 inches]

3. The [Select PLC Type] dialog is displayed. Select a PLC model, then click [OK].
According to the selected PLC model, the [Comm. Parameter] dialog may be displayed. After checking the

setting, click [OK].
9 cliek (0K x|

[=- MITSUBISHI ELECTRIC j

link.

& series CPL
- And series link
Gnd series CPU
QrHI0) series link
QnH[A) series CPU
QnHIE) series CPU
G00/00/01 CPU
- ¥ series CPU
- F2M series CPU ;I

 Display Muliiink2 PLC
( Display All FLC

Cancel
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4. The [Screen [0] Edit] window is displayed. Start screen editing.

[ v Series Editor for Windows Yersion 2.10 [ untitled.v6 ] ¥609E (640%400 &3 inches) - [Screen[0] Edit =101 x|
() Fle Edic Display Draw Part ltem SystemSetting Tool Window Help - (8] x|
DEHEwE ws £ @-bewE|? Division No. =
JEet" BEEPE U CE - BEEGERIEEAR BuOBERBEEER]|
PR IS I AN me ~ 8]/ 00 @R - 1 1 B

1
4| J _»ILI

Ready 447: 105 2 100% % Base
v

Restrictions on Creating New Screens with V609E

When creating a screen newly using V609E, restrictions indicated below should be taken into consideration.

@ Screen memory
About 760k bytes (could increase according to the font to be used)

Expansion of memory size is not allowed.

@ Overlap size
Although up to 3 overlaps can be displayed simultaneously on a screen, data size for overlapping is
limited.
Total data size of overlaps is 256,000 bytes.

Example 1) Creating a single overlap
640

< »
< »

Overlap No. 0 640 x 400 = 256,000 <= 256,000

400
* Displaying other overlaps is not possible.

A 4

Example 2) Creating two overlaps

500 N 500 x 300 = 150,000
t Overlap No. 0 250
200 _ « » 250 x 400 = 100,000
Overlap
! No. 1 150,000 + 100,000 = 250,000 <= 256,000
400

* Another overlap of up to 6,000-byte
size may be registered.

* When a total data size of overlaps displayed in one screen exceeds the limit indicated above, error message
“Data has some error Error:54” is displayed in V609E and communication with a PLC is disabled. Always
observe the limit of the data size when creating overlaps.
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@ Display colors
V609E has only two colors - black and orange yellow.

The relationship between the color setting at the editor and displayed color on V609E is indicated in the

table below.
Software V-SFT V-SFT
setting ) ) )
(Default) Setting of [Display: Reversed image]
([Unit Setting] --> [Backlight])
Black | Other than black Black Other than black
Hardware
V609E Black | Orange yellow |Orange yellow Black

Create a screen taking the relationship above into consideration.

Select [Display Environment] from the [Display] menu.

Check the [Monochrome 8-grade Display] and click [OK].

Display Environmenkt

Detail I Menu Dsp.l Grid  DOthers I

Zoom I 100% = l

C ¥ Monochrome S-grade Display )

¥ Interlock text in the switch.

™ Limit of E dit Model Area

I Mot display overlaps when Base is selected

W windaws 2000/MT 4.0 paint processing

I Erlarge iterns including circles in the oppozsite angle.

Display colors on the screen are set as shown below with the setting above.

* Itis possible to check the display image using the screen editor.

In the [Display Environment] dialog, click the [Others] tab window.

V-SFT V-SFT
[Display Environment] Setting of [Display: Reversed image]
(DefaUIt) ([Unit Setting] --> [Backlight])
Software
[[OMonochrome 8-grade Display] | Black | Other than black Black Other than black
[MIMonochrome 8-grade Display] | Black White Black White
Hardware V609E Black | Orange yellow |Orange yellow Black
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3 GD-80E -> V609E Conversion

2 GD-80E -> V609E Conversion

CONSIDERATIONS ON HARDWARE

When you replace GD-80E with V609E, note the following points.

Model
Item

GD-80EH/EO

V609E

Countermeasures

Effective display
area

8.9"

8.9"

Panel cutout
dimensions

277 W x192 H mm

277 W x192 H mm

Display device

GD-80EH :
High-intensity EL
GD-80EO : EL

High-intensity EL

Use high-intensity EL also to replace
GD-80EQ (EL).

Resolution for
display

640 (W) x 400 (H)
dots

640 (W) x 400 (H)
dots

Resolution for
touch switches

20 (horizontal) x 10
(vertical) switches

40 (horizontal) x 20
(vertical) switches

nector (For direct
connection to
Mitsubishi A/IQ/FX
CPU)

Available

Direct connection to
CPU is possible
using standard D-sub
25-pin connector

(Matrix type) (Matrix type)
External I/O With RUN, STOP and| RUN, STOP and BZ None
terminals BZ terminals terminals are not
available.
RS-422 terminal | (Only for GD-80xxx0) | Not available Use terminal converter TC485 or
Available TC609 (only for V609E) (product of
Hakko Electronics: both options).
D-sub 15-pin con- | (Only for GD-80xxxM)| Not available *To use MB-CPU

(cable for D-sub 15-pin connector)

Use terminal converter TC609 +
MB-CPU .

* To connect to CPU using D-sub 25-
pin connector

Use D-sub 25-pin connector cable,
MB-CPUQ .

Screen data
transfer cable

Connected to D-sub
25-pin connector.
GD-CP

GD-CPV

Connected to modu-
lar jack. Accordingly,
the cable prepared
for GD-80 cannot be
used.

Use screen data transfer cable for V6,
V6-CP (product of Hakko
Electronics).

Communication
cable

Connected to D-sub
25-pin connector.

Connected to D-sub
25-pin connector.
Accordingly, the ca-
ble prepared for GD-
80 can be used.
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Model
Item

GD-80EH/EO

V609E

Countermeasures

Printer port

Centronics 14-pin
connector Standard
printer cable for
PC-9801 is used.

Half-pitch 36-pin con-
nector Accordingly,
the printer cable pre-
pared for GD-80 can
not be used.

Use printer cable for V6, V6-PT
(product of Hakko Electronics).

Barcode reader
connection

(Only for GD-80xx2x)
D-sub 9-pin connec-
tor is available.
Standard specifica-
tion provides the con-
nector for barcode
reader.

Connected to the
modular jack.

Use barcode reader cable for V6,
V6-BCD (product of Hakko
Electronics).

Storing screen
data in memory
card

Can be stored using
recorder,
GD-MRECO1 .

GD-MRECO1 can
not be used.

Use card recorder for V6, CREC
(product of Hakko Electronics).

Memory card

(Only for GD-80xx2x)

GD-MRECO02 can

Use card recorder for V6, CREC

function Compatible by using | not be used. (product of Hakko Electronics).
recorder,
GD-MRECO02 .
Memory card Flash ROM Cannot be used Store the memory card data using
REC-MCARD directly. GD-SFT80WE then read and convert
the data using V-SFT.
SRAM Cannot be used * If the memory card was used to
directly. store the screen data backup:
Store the memory card data using
GD-SFT80WE then read and convert
the data using V-SFT.
* If the memory card function was
used:
Change the applicable model name
written to the memory card using
M-CARD SFT (to be purchased
separately).
Protective screen | [GD-GSS80E] [GD-GSB80E] —
filter
Water-proof [GD-WPSOE] [GD-WPS8OE] -

screen filter

(Complies with 1P64)
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CONSIDERATIONS ON SOFTWARE

Converting Procedure
1. Start V-SFT, then click the [Open] icon, or select [Open] from the [File] menu.

@U Series Editor for Wi
@U Series Editor for Window File

File: [ Mew Chrl+h
O =-R=iE) Or = Open..,

¥ Transfer...
Send AT command...

e

=

2. The [Open a screen data file] dialog is displayed.
Change the [Files of type] to [*.80].

Open a screen data file. 2l
Look in: I@ Data j " EF ER-

File hame: =T Open I

Files of type: | Cancel |
4
3. The GD-80 screen data files are displayed in this dialog.
Specify the GD-80 screen data file to convert, and click [Open].
Open a screen data file. 2lxl

|« & ek B

File hame: |GD-SUE ( Open I
Files of tpe: |*_SD j Cancel |

Z

4. The [Edit Model] dialog is displayed.
Select [V609E (640*400 8.9 inches)], then click [OK].

Edit Model

VEDSE (540°400 8.9 inches) =]

V7125 (B00°600)
Y7105 (200%600)
Y7107 [B40°430)
_|wr0es (@00+s00) i
V70RC [EA0°420)
YE12 (S00°B0012.1 inches)
YET0S (B00°600 10,4 inches)
VBI0 (5407450 10.4 inches)
YEOD (G40°4B07.7 inches)
VEDE (32024057 inches)
)

WEOGI (320240 5.7 inches)
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5. The screen edit window is displayed.
GD-80E screen converted for V609E is displayed.

[E3)¥ Series Editor for Windows Yersion 2.10 [ D:¥Data¥GD-80E.¥6 ] ¥609E (6

() File Edt Display Draw Park Item System Setting Tool Window

=101x]
tep @] x|

DEEowd|w? L @ e smE?

Division No. =

Een " BEEPEENCEE R EEREME AR ESMEEE

I 112341232
123411232

S

AEC
e

EREa

e I |
Line N

1800 42 Z: 1009 2% Base

Cautions on conversion
Conversion contents are largely classified into two categories when converting the GD-80E screen data into

the data for V609E.

@ Data converted as GD-80 compatible data
@ Functions that cannot be converted as GD-80 compatible data (as of V-SFT Ver. 2.2.0.0)

Described below are cautionary items to be taken into consideration for each conversion content.

Model
Item

GD-80E

V6

Continuous buzzer

The buzzer keeps sound-

Possible

12 is ON.

(The overlap is kept dis-
played even if the display
is changed.)

sound ing while read area n, bit | By checking [Use continuous buzzer sound] in the

10 is ON. [Environment Setting] tab window of [Unit Setting]
Overlap bit Overlap is displayed Possible
command while read area “n+1", bit | By checking [Display an overlap be level of ON bit] in the

[Environment Setting] tab window of [Unit Setting]

With check mark :
Without check mark :

Same operation as GD-80.

Bit 12 setting is recognized at the
signal edge.

(Even if the bit is set ON, the overlap is cleared when the
display is changed.)

Character entry
mode

Continuous entry of
characters is permitted
even after pressing the
[ENT] key.

Possible

By checking [Clear characters when cursor is on the
1st character in Entry Mode] in the [Environment Setting]
tab window of [Unit Setting]

Calendar display

Message representing
day of week is registered
in message edit

Possible

Calendar is converted as [Calendar parts] and the mes-
sage in the message edit is automatically copied to and
registered in the [Week] tab window in the calendar parts.
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Model
Iltem

GD-80E

V6

Bar code reader

[Read Data] to be enter-
ed in the memory ad-
dress set for [I/F
Memory] of [Bar Code
Setting] is “word units.”

Possible

By checking [Output the number of data read by a bar-
code reader by words] in the [Environment Setting] tab
window of [Unit Setting]
With check mark : Same display as GD-80.
Without check mark : To be output in byte units.

Relay mode /
Page mode /
Direct mode
([Action: Switch/
Lamp])

If a message overflows
the switch/lamp area,
overflowing characters
are not displayed.

Example) Switch

ABCDEFGHIJKLMNO

Actually, characters “P...U”
continue after “O.”

<Previous Version>
If a message overflows the switch/lamp area, overflowing
characters are continuously displayed in the second line.

On V6

ABCDEFGHIJKLMNOP
QRSTU

Message is displayed
in multiple lines.

<V1.2.19.0 or later>

Possible

By checking [Make messages same as in GD-80 if [Action
area] is [Switch/Lamp]] in the [Environment Setting] tab
window of [Unit Setting]

ABCDEFGHIJKLMNO

Numerical data
display

In the case of overflow,

lower digits are displayed.

Example: D100 = D1234
4-digit display: 1234
2-digit display: 34

Possible

By checking [Num. Display: displays the significant
figures when overflowing] in the [Environment Setting] tab
window of [Unit Setting]

With check mark : Same display mode as with GD-80.
4-digit display: 1234
2-digit display: 34

Without check mark : Display is given in the manner
shown below.

4-digit display: 1234

2-digit display: --

Numerical data
display

In the setting of [Code:

BCD], display at the GD-

80 is as shown below.
PLC side GD-80 side

Oto9 Oto9
A
B
C -
D +
E (space)
F (space)

Possible

By checking [Num. Display: displays special charac-
ters instead of Ato F in BCD] in the

[Environment Setting] tab window of [Unit Setting]

With check mark : Same display mode as with GD-80.
Without check mark : “A” - “F” are always displayed in “0.”
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Model
Item

GD-80E

V6

Switching over of
numeric data
blocks (Numeric
key mode, [Action:
Plus block/Minus
block] switch)

Switching over is pro-
cessed even when un-
registered numeric data
blocks exist between
[Start No.] and [End No.]
of switching over target
[Block No.].

No. 4

Example)

n

Unregistered

— [

All blocks, including
unregistered blocks
are switched over.

<Previous Version>

If an unregistered numeric data block exists within switch-
ing over target block range specified by [Start No.] and
[End No.], block switching over processing is suspended
at an unregistered block.

Example)

Switching over possible ! Switching over impossible

No. 3 No. 4

Unregistered block

Switching over is impossible for blocks that appear
after the unregistered block.

<V1.2.19.0 or later>

Possible

By checking [Skip tenkey block which doesn't exist
when operating +/- block switch] in the [Environment
Setting] tab window of [Unit Setting]

No. 1 No. 3 No. 4

»
»

Unregistered blocks are skipped.

Graphic relay
mode on overlap

Datum point —

When a graphic relay is
set on an overlap, the
registered graphic is
displayed in reference to
the datum point of the
screen.

Example) Graphic library

o

J

——

Overlap

Screen

<Previous Version>

For the display of the graphic relay on an overlap, the reg-
istered graphic is displayed in reference to the datum
point of the overlap.

Datum point

—> o

<V1.2.19.0 or later>

Possible

By checking [Regard the origin of graphic relay on an
overlap as that of a screen] in the [Environment
Setting] tab window of [Unit Setting]

Overlap

Screen

Datum point Overlap

Screen
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Model
ltem GD-80E V6
Switches/Lamps | When a switch/lamp <Previous Version>
having the same OFF On the editor or MONITOUCH, display is always given i
color as the background | n the state the switch/lamp set on top overwrites the one
color is set, the objective | set at bottom.
dlslplgygd I.n ttl:le OFF Example) Lamp (top)
color is invisible. e on Ve
Example) Lamp(top) : ::>
Switch (bottom) Lamp overwrites switch.
""" <V1.2.19.0 or later>
Switch (bottom) Possible
By checking [Not paint when switch/lamp OFF color is
on GD'BO@ the same as back color] in the [Environment Setting] tab
window of [Unit Setting]
Although overwriting occurs on the editor as the previous
version, display on V6 is given in the same manner as
GD-80.
Lamp (top)
At OFF, the lamp is invisible. [ : On V6
| g
Switch (bottom) At OFF, the lamp is invisible.
Switches In the state two switches | After the conversion, the switch assigned a larger number

overlap with each other,
the switch assigned a
larger number (or a
larger DIV No.) responds
when the switch overlap-
ping area is pressed.

If you press this area,

No. 0 \

|

No. 1

On GD-80

Switch No. 1 responds.
No. 0

No. 1

Possible

(or a larger DIV No.) comes top over the one assigned a
smaller number (or a smaller DIV No.) on the editor.

No. 0

No. 1

<Previous Version>
Pressing the overlapping area causes the switch set
bottom to respond.

If you press this area, .
Switch No. 0 responds.

No. 0

On V6

—>

No.O |

No. 1 No. 1

<V1.2.19.0 or later>

By checking [Make the upward switch effective when
switches are overlapped] in the [Environment
Setting] tab window of [Unit Setting]

If you press this area,
Switch No. 1 responds.

No. 0

No.O | on Ve

=

No. 1

No. 1
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Model
Item

GD-80E

V6

Character 1/
Character 2

Usage differs between
Character 1 display and
Character 2 display.

<Character 1 display>

* 1-byte characters and
2-byte characters are
distinguished.

* For 1-byte characters,
NULL code is process-
ed as indicated below.

(In LSB --> MSB)

D100 = HO041
D101 = H4443

H41 00 4344

D100 = H4200
D101 = H4443

_BCD)

H 00 4243 44

* 2-byte characters are
displayed in JIS code.

Conversion is made in [Char. Display].
Compatibility to character display on GD-80 is possible
by checking [JIS/ASCII] of the [Detail] tab window.

<Character 2 display: [] JIS/ASCII>

 Unlike GD-80, NULL code is processed as indicated
below.

Character-string following 00 is

—
not displayed.
—>
H41 00 4344

Character-string following 00 is
not displayed.

[T S T—

H 00 424344
» Compatible with JIS code

<Character 1 display: M JIS/ASCII>
* In case of [@1-byte]
Same display as GD-80
Same NULL code processing
* In case of [@®2-byte]
Display 2-byte characters in the same JIS code as
GD-80

Switching the
numeric keypad
to HEX data entry
keys

The [-/+] key in the nu-
meric keypad is automat-
ically changed to the
HEX entry selection key.

Example)

Changed to the HEX
entry selection key.

<Previous Version>

The [-/+] key in the numeric keypad is not changed to the
HEX entry selection key automatically. It is necessary to
set the HEX entry selection key ([Function: Graphic
Library]) for the individual appearances.

<V1.2.19.0 or later>

Possible

The [Change GD80 Compatible HEX Key] item is added
to [Function].
Identical operation as with GD-80 (as shown in the left)




3 GD-80E -> V609E Conversion

Item

Model

GD-80E

V6

Data sampling

<L

The count data is dis-

played in the leftmost
column.

<Previous Version>
The count data is not displayed, but the leftmost column
is left blank.

Screen library is set in
the following manner

Screen No. 4 (DIV 3)

“"Screen library "
Div 2 .
screen library
Div. No. 3
Screen No. 4

Graphic

—

000 55 113 3345 55 113 3345
001 64 119 3450 64 119 3450
002 33 106 3250 33 106 3250
003 48 121 2956 48 121 2956
004 56 107 2246 56 107 2246
<V1.2.19.0 or later>
Possible
By converting data [No. 15] on [Sampling Display Area]
automatically to count display area.
[Sample Count] item is added to the [Data [15]] dialog.
* The count position setting [C], necessary for printing the
sampling data, is automatically converted to [15] for printing
the count data. (In message editing)
Screen library Example) <Previous Version>

Not converted as the screen library

Screen No. 4 (DIV 3)

Screen No. 7

ERROR DISPLAY

<V1.2.19.0 or later>
Possible
Screen library is converted as shown below.

In the screen library,
items on the source screen
are copied.

Screen No. 4 (DIV 3)

Screen No. 7

Screen library No. 454 (DIV 3)

Screen calls are set on the individual screens
(source screen of GD-80 and target screen).

How to calculate the screen library No. after conversion:

Screen library No. = Original screen No. + DIV No. x 150

=4+3x150
=454
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Item

Model

GD-80E

V6

--> Continued
(Screen library)

Example) GD-80
Screen No. 4 (DIV 3)

Screen library
] Graphic

Screen No. 10
Pre NXT

1234 1234 1234 1234
1234 1234 1234 1234

1234 1234 1234 1234

Screen library The setting at the screen having a larger screen number at GD-80 has priority.

If [Graphic] is checked for screen library at GD-80, the graphics is moved to screen
library at V6. However, if the same screen library is used with [Graphic] checked and
unchecked at GD-80, the setting for the screen assigned a larger screen number has

priority.

V6
Screen library No. 454 (DIV 3)

A

The status of the screen
having a smaller screen
number at GD-80 differs
that of the screen display-
ed on GD-80.

1234 1234 1234 1234
1234 1234 1234 1234
1234 1234 1234 1234

Graphic
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Model
Item

GD-80

V6

Read/Write Area

Possible
[Main 1] tab window of [Comm. Parameter]
Check [Read/Write Area GD-80 Compatible].

Background of
screen

« Screen with only back-
ground color

« Screen with only back-
ground graphics

* Screen with both back-
ground color and

--> Converted as unregistered screen
--> Converted as a screen with a graphic call

--> Converted as a screen with a background color and a
graphic call

graphics
Overlap * Normal --> An overlap is registered in the same number of a
No items are registered multi-overlap edit as one of a screen in GD-80 auto-
in a screen except an matically.
overlap in DIVO.
 Other items except an | --> An overlap is registered as a normal overlap in a
overlap are registered screen. And an overlap is also registered in the same
in other DIV, or an number of a multi-overlap edit as one of a screen in
overlap is not registered GD-80 automatically.
in DIVO.
Switch/Lamp [Frame type: graphics] [Graphic Call] is automatically set on the screen for
creating/editing switch/lamp parts.
Switch [Switch Memory] of the
following [Function]:
[Normal]
[Block]
[+/- Block]
[Mode]
[Bit Operation] --> Converted to [Output Memory].
Relay mode * DIVO --> Converted to [Relay Info. Output] as Write Area n+5.
» DIV1 --> Converted to [Relay Info. Output] as Write Area n+8.
* DIV2 --> Converted to [Relay Info. Output] as Write Area n+11.
*DIV3 --> Converted to [Relay Info. Output] as Write Area n+14.

Tenkey mode

Entry mode

» The contents of [Command Memory] are the same as
that of GD-80.

» Write Area n+2 is automatically specified for [Info.
Output Memory].

* Characters in a keypad
[0] to [9] and [.] are converted to the drawing characters
on a screen.
[0] to [9] and [.] are also stored in [Char. Entry] in the
[Switch] dialog in 1-byte character.
The characters within the switch are placed off the
screen so that they do not cover the drawing characters.
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Model
Item

GD-80

V6

Tenkey mode

[Type: Direct]

[Type:
Indirect]

[Type: Block]

[Type:
Block Direct]

[Type: Multi]

* [Type: Direct]

* For numerical displays on a screen, [Display Function: No] is set.

* [Type: Data Display]

* [Target Memory: Output Memory]

* [Input ltem Select: External]

* [GD 80 Compatible: (checked)]
When there is no overlap, "4" is set. When there is an overlap, the
DIV No. for the overlap of GD-80 is set.

 For numerical displays on a screen, [Display Function: Entry
Target] is set. The number of [Order] is converted automatically as
shown below.

GD-80 V6
DIV No. Data No. Order
0 0to 31 0to 31
1 0to 31 321063
2 0to 31 64 to 95
3 0to 31 96 to 127

* [Type: Block]
* [Target Memory: Output Memory]
* [Input ltem Select: Internal]
+ [GD 80 Compatible] cannot be specified (but checked).
* The settings of tenkey blocks are set in DIV4 as settings for [Data
Block Area] mode.
[Data Block Area] mode
- [Division No: 4]
- [Command: Internal]
- [Initial Block/Min. Block: (Set the number of [Start].)]
- [Max. Block: (Set the number of [End].)]
- [Item Select: (unchecked)] (Set if necessary.)
- [GD 80 Compatible: (checked)]

* [Type: Block]
* [Target Memory: Direct]
* [Input ltem Select: Internal]
» [GD 80 Compatible] cannot be specified (but checked).
* The settings of tenkey blocks are set in DIV4 as settings for [Data
Block Area] mode.
[Data Block Area] mode
- [Division No: 4]
- [Command: Internal (same as GD-80)]
*When [Command: External] is set, the address of [Block No. Read Mem.]
is the same as of [Command Memory] in [Entry] mode.
- [Item Select: (checked)]

* Specify the same number as [Command Memory] n+1 and choose [2]
words.

- [GD80 Compatible: (checked)]
* [Typel, [Target Memory], [Input Item Select] and [GD 80 Compatible]
are set same as that in case of [Type: Block Direct].
* The settings of tenkey blocks are the same as that of [Data Block
Area] mode in case of [Type: Block Direct].

*When [Command: External] is set, the address of [Block No. Read Mem.]
is the same as of [Command Memory] in [Entry] mode. When the overlap
containing the keypad is stored in another screen (= multi-overlap is
used), [Block No. Read Mem.] is temporarily set in [$u4000]. Be sure to
change it from [$u4000] to the address of [Command Memory].
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o —Model | 5p.gp V6

Character Entry
mode

Entry mode
* [Type: Data Display]
* [Command Memory: (same as [Memory] in GD-80)]
* [Info. Output Memory: (converted to Write Area n+2)]
* [Target Memory: Direct]
* [Input Item Select: Internal]
* [Detail] tab window
[Use Graphic: (checked)]
(Both [Start Graphic] and [End Graphic] are automatically set same as
[Initial Graphic No.] of [Character Entry] mode in GD-80.
If necessary, specify [End Graphic] later.)
* For character displays on a screen, [Display Function: Entry Target] is set.

Statistics graph » The DIV No is converted as follows.

mode DIV No. 0 1 2 3
GraphNo. ||0 1 2 3 |01 2 3 |01 2 3 |01 2 3
V6DIVNo. || 0 10 11 12 | 1 20 21 22 | 2 30 31 32 | 3 40 41 42

* For [Result Display: checked], the numerical display [Display Function:
No] is set in the same DIV No. as that of a statistics graph. [Memory] of
each numerical display is the same as [Memory] of the graph.

* For [% Display: checked], the numerical display [Display Function: Display
Statistics Graph %] is set in the same DIV No. as that of a statistics graph.

Incompatible Functions after Conversion

There are functions for which compatibility with GD-80 cannot be maintained after converting to V6.
The following describes these functions

tem Model GD-80 V6

General-purpose | General-purpose serial Impossible

serial communi-
cation

communication protocol,
special to GD-80, is used,

Since the general-purpose communication protocol,
special to V series, is used, the protocol is not compatible.

Communication
parameter

Baud rate
1200 and 2400 bps are
available.

Impossible
Both baud rates are automatically converted to 4800 bps.

Display characters

Characters to be display-
ed are not influenced by
Enlarge X/Y setting.

When an even value is set for Enlarge X/Y, such
characters are automatically displayed in 32-dot font.
Accordingly, displayed image will somewhat differs from
the characters displayed at GD-80.

(When [Japanese 32] selected in [Font Setting] of
[System Setting] as font is changed to [Japanese],
displayed image will come close to the characters
displayed at GD-80.)

Overlap
[Type: Multi]

Memory n:

Indicates the screen No.
where the displayed
overlap is registered.

When the overlap is
cleared, the screen No.
entered last remains in
memory n.

Memory n:
The number in the [multi-overlap] in which the displayed
overlap is registered.

When the overlap is cleared -1 (= HFFFF) is setin
memory n.

Character-string of
switch/memory

Character-strings are
created in graphics.

Character-strings are converted as graphics.
They are not converted as character-strings in the
[Switch] (or [Lamp]) dialog.
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Model
Item

GD-80

V6

Numeric key mode
[Type: Direct
Command]

Memory n:

Clear (bit 15)
The write flag and dis-
played value of numeric
data entry are cleared at
the timing this bit is
turned ON (0 --> 1).

Memory n =H0084
(DEC/4-digit designation)

8 5139
J

4
Entry of
numeric data
Memory n =H8084
(Clear: DEC/4-digit designation)

4

Input mode [Command Memory]: n

Clear (bit 15)
When this bit is turned ON, the write flag is cleared, and
the display of entered data itself is also cleared.
Entry is enabled when data type and the digit number,
etc. are designated after turning OFF the clear bit (bit 15).

Memory n =H0084 (DEC/4-digit designation) --> Entry of numeric data

jo 5131
v

71
Memory n = H8084 (Clear and type designation) --> Memory n = H0084

4 7

Numeric key mode
[Type: Block Entry]

Memory n:

Clear (bit 15)
After the entry of numeric
data using the numeric
keypad, the keys are
completely disabled.
At the leading edge (0
--> 1) of bit 15, the write
flag using the numeric
keypad is cleared and
the keypad disabled state
is canceled.

All switches are disabled.
until the clear bit is set ON.

Entered value 5130f]

Input mode [Command Memory]: n

Clear (bit 15)
After the entry of numeric data using the numeric keypad,
entry for the same data item is not allowed. However,
since the clear (CL) key is valid, the numeric keypad is
enabled by pressing the clear key.
In addition, since the [UP] and [DW] keys are always
valid, entry using the numeric keypad is accepted after
moving the cursor to the next data entry objective data
item.
To enter the data for the same data item continuously,
this bit is valid

Only these keys are valid.

0.00

Trend graph

Control Memory
Memory n specified by
each [0 to 15 tab
windows] (n exists by
the number of display
counts)

Graph value memory
Memory n (specified by
each [0 to 15 tab
windows]) + 1

Control Memory
Only memory n specified by No. 0 of graph at GD-80
(All graph broken lines are controlled by memory n)

* |t is not possible to gain the totally identical control as GD-80.

Graph value memory
Memory n (specified by each [0 to 15 tab windows]) + 1

Sampling
(Bit / Data / Trend)

During scrolling in the
sampling data area using
the [Roll Up]/[Roll Down]
/[Plus Block]/[Minus
Block] switch, nothing is
displayed in the display
area.

During scrolling in the sampling data area using the [Roll
Up]/[Roll Down]/[Plus Block]/[Minus Block] switch, the
cursor is displayed and the data currently selected can be
recognized.
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tem Model GD-80 V6
Sampling Count value is displayed | Numeric values [Display Function: Sample Count Display]
(Trend) only at V6. [Digits: 3] and [Char. Type: 1/4] are set at the lower left
area of the graph.
Count of the zero position|
is displayed at the lower | The current count is displayed.
left area of the graph.
Sampling A space of 1-byte chara- | A space of four 1-byte character size is provided between
(bit) cter size is provided the display in the area and the message.
between the display in the
area and the message.
Memory card Card No. Card No.
mode /Card name /Card name
/File name /File name
/Record name edit /Record name edit

Edited and entered No./| Impossible
name are once stored in| Since No./name is directly written in the memory card,

the PLC memory. nothing is stored in the PLC memory.
Switch [Action] Switch [Function]
« [File Select] -> [File Select]
* [Record Select] -> [Record Select]
* [Selection Complete] -> (None)

To select a file/record in | To select a file/record in the card, follow either of the

the card, follow either of | procedures below.

the procedures below. [File Select] -> (1)(2) (Press the display area)

[File Select] -> (1) [File Select] -> [Record Select] -> (Press the display area)
[Selection Complete] ->
(2) [Selection Complete], | The operation press the display area is used instead of
or [Record Select] -> pressing the [Selection Complete] at GD-80.

[Selection Complete]

Card No. 0 File No. Card No. 0 FileNoi 3 » Card No. 0 File No. Card No. 0 File Noi 3
Card Name Hak_File Name Card Name Hak File Namé: TU-008' Card Name Hak File Name Card Name Hak File NameTU-008"
0. Produce File Selec M _ Te--
P o feoed B BB — |E=d
=== < B \
[fee see| Jecseed|
A ‘\
Switch [Action] Switch [Function]
« [File Name Edit] -> [File Name Edit]
* [Record Name Edit] -> [Record Name Edit]

Press [File Name Edit] or| Select a file or a record after turning ON the [File Name
[Record Name Edit] after | Edit] or [Record Name Edit] switch, and the multi-overlap
selecting a file or a re- for which the entry mode is set is displayed.

cord, and the multi-over-
lap for which the chara-
cter entry mode is set is
displayed.

1 @
\
-~ r g v
Record No. 0 RecordNo. 0 [ Fecora secd | | Fecorateme MY
Record Name TUA Record Name TU, & ecord Seleq £
\ 3
ile Name Ed il -
/—

iec Name Eil "

i~
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Model
Item

GD-80

V6

Editing No./name
in the memory
card mode

» Multi-overlap is always
used.

« Editing is impossible
unless [Memory] bit 12
of the numeric keypad
entry mode/character
entry mode for No./
editing is set ON.

» An overlap is deleted
when the [ENT] key is
pressed and the card
No. or the card name
[file name/record name
is entered

Screen No. 20 (GD-80)

Record Name

ABC

For the screen on GD-80, where nothing is registered

other than the norm

AN

2) Entry mode
X [Type: Data

al overlap.

At V6, the normal overlap is automatically reg-
istered in the same number as multi-overlap edit. '

In the state after conversion, converted data cannot be
used as it is.

Take the following into consideration.

1) In the state the normal overlap for [Type: Multi] is reg-
istered in the screen, the overlap is transferred to the
same area of the screen No. of [multi-overlap edit].

2) The entry mode on the overlap is always changed to
[Type: Memory Card].

3) [Num. Display] parts or [Char. Display] parts of
[Display Function: Entry display] are always set in the
same DIV as the entry mode on the overlap.

4) If [Data Block Area] is set on the overlap, it is deleted
since it is unnecessary.

5) Name display parts are automatically converted in
[Bytes: 3]. Therefore, setting should be changed if
necessary.

The memory card mode operates normally by the setting
indicated above.

* [Command Memory] operation in the [Entry] mode is
not necessary.

5) For checking [Bytes]

File No.

- 3
Record Name 23

Qisplay (or Block)]

|
\/ [Type: Memoly Card

Display function: Entry Target

Display Function: Entry Display

| : File Name .

N —— N —
ecord Selec ec Name -ﬂ
fe— f—\

L2 1¥]

Screen No. 19 (V6)

Multi-overlap edit No. 20 (V6)

Line

Among the eight kinds of
lines, four kinds of lines
can be edited as needed.

Impossible
Six line kinds are provided in total and all of them are
fixed.
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